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Introduction 
 

Overview 
The dissertation manuscript is a permanent document that reflects on the writer, the school, and 
the university. The purpose of these formatting guidelines and the format editing process is to 
ensure that the presentation of the dissertation matches the same high quality of the research 
and scholarship that went into writing it. 
 
Like most universities, Capella publishes dissertations through ProQuest (formerly, University 
Microfiche Incorporated). ProQuest acts like a typical publisher in many respects but differs in 
others. For example, it does not provide format editing or typesetting services. The appearance 
of the manuscript when it is delivered to ProQuest is the way it appears in published form. 
Since dissertations represent the scholarly output of the university to the entire academic 
community, it is in the collective best interest of all involved that the final product is as 
polished as it can be. The committee and the format editor work with learners with the intent of 
guiding them to produce the best possible document in both content and presentation. 
 
Capella uses the Publication Manual of the American Psychological Association (APA) (5th 
ed.) as its foundation. Capella’s Dissertation Format Guidelines align closely with APA. The 
Guidelines provide instructions and advice, but they do not offer a comprehensive discussion 
of APA style. For that, learners must familiarize themselves with APA. 
 
 
How to Use These Guidelines 
The Dissertation Format Guidelines address just that: formatting. It is assumed that learners 
have read the Dissertation Manual and have a working familiarity with the APA Manual. These 
guidelines address content only as it relates to formatting (e.g., appendix material, copyright 
notes, cross-checks on maintaining confidentiality of research subjects).  
 
You may find it useful to print out a hard copy of the Dissertation Format Guidelines. Skim 
through the document, highlighting any areas you feel may be particularly beneficial. Refer to 
the guidelines during the entire writing process. 
 
These guidelines are written to be used in conjunction with the Dissertation Template 
 and with the APA Manual. You are encouraged to rely on the many samples contained in this 
document and on the dissertation template itself, which functions as a sample for page layout 
and sequence, as well as formatting and required text. You are also encouraged to read the 
relevant sections in APA that are cited in these guidelines. 
 
Be wary of using dissertation samples from Capella or from other universities. These 
guidelines supersede any other formatting guidelines or instructions. 
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Chapter Contents 
Chapter 1 contains the “nuts-and-bolts” overview for dissertation formatting, beginning with 
the title page and ending with the appendix. Sample pages illustrate page margins, headings, 
lists, block quotes, and the reference list. 
 
Chapter 2 discusses formatting tables and figures. This chapter, too, includes illustrative 
samples and tips for formatting tables and figures.  
 
Chapter 3 expands on chapter 1. This chapter thoroughly reviews the perceived discrepancies 
between APA and Capella formatting requirements and tips for using Microsoft Word to 
prepare a dissertation.  
 
Chapter 4 contains an annotated list of the trouble spots the format editors have noted across 
Capella dissertations, including confidentiality issues. The chapter closes with a list of useful 
resources. 
 
Chapter 5 covers copyright compliance. There is much attention in the publishing world on 
issues of plagiarism, accidental plagiarism, and ownership of intellectual property. Writers 
planning to incorporate tables, figures, or surveys from outside sources will find this chapter 
crucial, but all writers should be well versed in copyright issues. 
 
Chapter 6 contains school-specific information about dissertations. 
 
 
 
Johannah Bomster and Marie Ward 
Format Editors
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Chapter 1. Dissertation Formatting 
 
General Formatting 

Required 
MS Word for PCs or Office X (Word for Mac).  
 

Dissertation Template  
Writers are strongly encouraged to use their school-specific Dissertation Template for writing 
the dissertation. It is important to write with the Show/Hide button clicked on (it’s on the 
standard toolbar) so that formatting elements such as section breaks and page numbering are 
not inadvertently deleted. (The icon for the Show/Hide button is the paragraph symbol: ¶.) 
 

Font 
Use Times New Roman or another clear, basic 12-point font. Use the same font throughout the 
manuscript (but see the discussion of text size for tables in chapter 2). Do not use ornamental 
font elements or script fonts. Do not use boldface or underlining for emphasis. 
 

Margins 
No print, including page numbers, must overlap into the margin areas of the page. See the 
MARGIN SPECIFICATIONS sample page in this chapter for margin settings. The correct margins 
are preset in the dissertation template, which writers are encouraged to use.  
 
 
Formatting the Preliminary Pages 
Sample pages of the preliminary pages are not included in this chapter. Instead, writers are 
referred to the Dissertation Template for viewing the overall layout and required text and 
formatting of the preliminary pages. 
 

Page Numbering 
Pages are not numbered until the Dedication, or the first page following the Abstract. See 
Table 1 in this chapter for which pages contain a page number and which do not. See the 
discussion of page number formatting under Dedication, below. 
 

Title Page 

1. Dissertation title. Centered, all caps, double-spaced, starting 3 inches from the top of 
page. See the dissertation template. 

2. Date. Month and year of conference approval. 

3. Required text. See the dissertation template. 
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Copyright Page 
Centered vertically and horizontally on the page: © Name I. Surname, Year 
 

Abstract 

1. Page title. APA level 1 heading, centered. 

2. Text. Double-spaced paragraph of approximately 350 words. Abstracts are published 
separately from the dissertation and thus should be self-contained; references to another 
author’s work should be completely cited or avoided. See APA 6.02.  

3. There should be no page number on the Abstract. 
 

Dedication 

1. Page title. APA level 1 heading, centered.  

2. Text. Aligned left (or centered if very short), double-spaced. See the Dissertation 
Manual for a description of what to include in the Dedication. 

3. Page number formatting. Enter page numbers, in lowercase roman numerals, centered 
in the footer. The Dedication will be page iii or iv, depending on the length of the 
Abstract (see Table 1, below). 

 

Acknowledgments 

1. Page title. APA level 1 heading, centered.  

2. Text. Double-spaced. See the Dissertation Manual for a description of what to include 
in the Acknowledgments. 

3. Spelling. Acknowledgments is spelled without an e after the g. 
 

Table of Contents 

1. Page title. APA level 1 heading, centered.  

2. Entries (see the dissertation template and Table 2 in this chapter): Acknowledgments; 
List of Tables; List of Figures; CHAPTER TITLE (all caps); level 1 headings from the 
chapters (no other levels); REFERENCES (all caps) and APPENDIX LETTER AND TITLE (all 
caps).  

3. Spacing, alignment. Double-space the Table of Contents but single-space entries that 
are longer than one line. Chapter titles are flush left; page references are flush right 
(with no leader dots). Level 1 headings are indented one-half inch. 
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List of Tables, List of Figures 

1. A List of Tables and a List of Figures should be entered on separate pages following 
the Table of Contents.  See the dissertation template. 

2. Page headings. APA level 1, centered. 

3. Spacing. Entries longer than one line should be single-spaced, with a full space 
between entries. 

4. Figure captions. Only the short figure description should be entered after the number, 
with no commentary or source notes. 

 
 
Table 1. What Takes a Page Number in the Preliminary Material? 

Item Is page counted? Does it take a page number? 

Title page Yes No 
Copyright page No No 
Abstract Yes No 
Dedication Yes Yes, p. iii (p. iv if Abstract is two pp.) 
Acknowledgments Yes Yes 
Table of Contents Yes Yes 
List of Tables (if used) Yes Yes 
List of Figures (if used) Yes Yes 
 
 
 
Table 2. What Should Be Entered in the Table of Contents? 

 
 
 

 

 

 

 

 

 

 

Item Entered in Table of Contents? 

Abstract No 
Dedication  No 
Acknowledgments Yes 
Table of Contents No 
List of Tables Yes 
List of Figures Yes 
Chapter titles Yes 
Level 1 headings  Yes 
Other heading levels No 
References Yes 
Appendix titles Yes 
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Formatting the Chapters 

Chapter Title 
APA level 5 heading. The entire chapter title should be all caps (see the Dissertation 
Template). Titles longer than one line should be single-spaced. 
 

Page Numbering 
Chapter 1 begins on page 1. Number pages sequentially from chapter 1 through the end of the 
manuscript, in arabic numerals, centered in the footer, in the 12 pt. font used in the rest of the 
manuscript. There should be no page numbering or text in the header. 
 

Spacing 

1. Margins: See the MARGIN SPECIFICATIONS sample in this chapter. 

2. Sentences. Insert one space, not two, between sentences. See APA 5.11. 

3. Paragraphs. Double-space paragraphs; indent the first line one-half inch.  

4. Headings. Add an extra space above headings to set off new topics. 

5. Tables/figures. Add an extra space above and below a table or figure to separate it from 
paragraphs or other tables/figures on the page. 

6. Single-spacing. Capella style encourages single-spacing for the following elements: 
• block quotations 
• lists (double-space between numbers) 
• reference list (double-space between entries) 
• table of contents (double-space between entries) 
• headings that extend beyond one line 
• table titles, table column and row headings, table text (double-space between 

rows), table notes 
• figure captions 

 

Headings 
1. See the HEADING SAMPLE at the end of this chapter for heading levels and formatting. 

2. Some tips for determining heading levels can be found in the discussion on heading 
hierarchy in chapter 4 of these guidelines. 

3. Refer to the discussion of heading levels in APA 3.31–3.32; also see the sample paper 
in APA 5.29. 
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Lists  
1. See the LIST SAMPLE in this chapter; refer also to APA 3.33. 

2. No bullets. Bullets, boxes, or other ornamental elements are not appropriate in a 
scholarly work.  

3. In-paragraph list. Use lowercase letters for lists within paragraphs.  

4. Numbered list. Use numbered lists as stand-alone paragraphs only, not within a 
paragraph.  

 

Numbers and Symbols 

1. Numbers. APA contains pages of exceptions to the use figures for numbers 10 and 
above “rule” (read APA 3.42a–g through 3.45). For example, figures are used for 
numbers that represent time, dates, ages, sample and population size, points on a scale, 
percents.  

2. Statistical symbols. See APA 3.58 and Table 3.9 for requirements for using symbols, 
such as %, and abbreviations, such as n, p, t test, SD, and so on. 

3. Equations. The elements of an equation should be spaced out like words in a sentence. 
See APA 3.59 and 3.60. 

 

Tables and Figures 
See chapter 2 in these guidelines. 
 

Quoting Sources 

1. Citing direct quotations. Cite every direct quotation by author, year, and page number. 
See APA 3.34.  

2. Using the work of another author. Obviously, you need to cite someone else’s work, 
but when do you need to request permission to use it? Read APA 3.41, 3.73, and the 
discussion of fair use of copyrighted works in chapter 5 of these guidelines. 

3. Reference citations in text. See APA 3.39 and 3.94–3.103. 

4. Formatting block quotations. See the BLOCK QUOTATION SAMPLE in this chapter. 
Direct quotations over 40 words should be formatted block style: indented one-half 
inch from the left margin (do not justify or indent from the right). Capella style allows 
single-spacing of block quotations to improve readability. Note that the end punctuation 
for a block quotation follows the quotation, not the citation (see APA 3.39).  

5. Using ellipses. Ellipses ( . . . ) are rarely needed at the beginnings or ends of direct 
quotations (it is understood that material precedes and follows the cited portion). See 
APA 3.38 and the discussion of ellipses in chapter 3 of these guidelines. 
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Formatting the Reference List 

The reference list establishes the author’s credibility as a careful researcher, and so it should be 
constructed with care. 
  

Page Title 
APA level 5 heading, centered, all caps. 
 

Reference Style  
The reference list is not a comprehensive bibliography; therefore, every reference should be 
cited in text and every text citation should be correctly referenced. 
 
APA reference style is not hard to use; it just takes some time to become familiar with. Chapter 
4, APA’s long chapter on the reference list, begins with an overview in APA 4.04 through 
4.07, with specific examples given in 4.08 through 4.15. Most of the formatting you need can 
be found in one of these sections. The examples in 4.16 cover a myriad of other situations 
within the categories outlined on pages 232–238.  
 

Reference List Format 
See the REFERENCE LIST SAMPLE at the end of this chapter. Each reference should be formatted 
with a hanging indent (Format > Paragraph > Indents and Spacing > Indentation > Special: 
Hanging). References should be single-spaced, with a full space entered between each 
reference. Do not split a reference between pages.  
 
 
Formatting the Appendixes 

Placement 
Appendixes are placed after the reference list. Each appendix should start on a new page. 
 

Appendix Title 
Appendixes are lettered, not numbered. See APA 5.19. The entire appendix title is an APA 
level 5 heading. Single-space titles that are longer than one line. Do not create a cover page for 
each appendix. 
 

Appendix Tables and Figures 
Multiple tables and figures each are numbered sequentially in each appendix, and they contain 
the letter of the appendix (APA 5.19). They should be added to the List of Tables and List of 
Figures. A single table or figure that comprises an appendix does not need a number; the title 
becomes the title of the appendix (APA 3.92). 
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What to Include in an Appendix 
There is a general tendency for learners to include unnecessary items in appendixes. Be 
judicious in selecting material for the appendixes: Appendix items should directly relate to the 
research.  
 
Do not include administrative documents.  

• The IRB and CITI forms support a supplementary administrative process separate from 
the dissertation itself and should not be included in the final manuscript. 

• You typically do not need to include copies of permissions, consent forms, and other 
documents relevant to the administration of the study, unless they are unique in some 
fashion as to warrant their inclusion. If you do include this material, be sure to black 
out any addresses, telephone numbers, and e-mail addresses to protect confidentiality. 

• Letters you have received acknowledging permission to reprint copyrighted material 
should not be scanned or reprinted in an appendix. However, you will be asked to send 
the letters to Proquest/UMI when you publish, as their publishing agreement will 
explain. 

 
Do not include résumés. Unless a learner’s expertise is substantiated by an extensive 
publication record and includes works regularly cited by scholars in the field, a résumé is not 
appropriate for inclusion in the dissertation. 
 
Should you include survey instruments?  

• If you used unmodified versions of instruments or protocols in standard usage within 
your discipline, you should not scan or reprint them in the manuscript; they are readily 
available to readers from other sources. Cite them clearly in the text of the manuscript.  

• Blank copies of learner-designed or learner-modified standard instruments or protocols 
are appropriate in an appendix.  

• If the instrument you used for data collection is not well known (consult with your 
mentor if you are unsure) or has not been published, it may be appropriate to reproduce 
it in an appendix.  

• If you include a modified or unmodified instrument in an appendix, in addition to 
getting permission to use it, you must have written permission to print it. You must also 
reference it in the appendix—this reference includes title, author, date, publisher or 
retrieval information, copyright date and owner, and permission statement (following 
the content and order of information in the sample references in APA 3.73). 

• Letters acknowledging permission to reprint a survey instrument should not be included 
in an appendix, but you should mention these permissions in the text. The letters will 
need to be forwarded to ProQuest/UMI, which their publishing agreement will explain. 
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Materials from other sources.  
• Complete reference. Appendix items reprinted or adapted from another source, 

including survey instruments, must be completely referenced, whether copyrighted or 
not. The reference must include this reference includes title, author, date, publisher or 
retrieval information, copyright date and owner, and permission statement (following 
the content and order of information in the sample references in APA 3.73). Read 
chapter 5 in these guidelines to determine if you need permission to use the work. 

• Scanned documents. Adjust the settings so a document is scanned at the optimal quality 
and size (this does not mean you should use the highest settings). Dissertations with 
scanned documents must not become so large that they cannot be e-mailed. 

 

Final Checklist 

After you have made editing changes and before completing the dissertation upload process 
that Capella will define for you, follow these steps:  

1. Do a final spell-check, but be aware that Word’s default dictionary frequently flags 
correctly spelled words as errors. Use Merriam-Webster’s Collegiate Dictionary (11th 
ed.) as the more reliable source for spellings questioned by your online dictionary. 

2. Print out your manuscript and do a final read-through on hard copy. This step should 
always be done by the writer, even when the manuscript has been edited by someone 
else. Many errors pop out on the printed page that look fine on the screen.  

As you read, mark the pages where you need to correct any spacing problems (your 
manuscript might not have these problems): 

 Odd page breaks and blank pages. There should be no blank or half-filled pages 
of text in the middle of a chapter or a short table/figure without text on the page. 

 A dangling line. There must be at least two lines of a paragraph at the bottom or 
top of a page; in paragraph formatting, this is called widow/orphan control 
(click on Format > Paragraph > Line and Page Breaks > Pagination). 

 A dangling heading. Use a page break to keep a heading from dangling at the 
bottom of a page. A heading must be followed by at least two lines of text 
before the page break. Also make sure table titles and figure captions appear on 
the same page as the table or figure. 

 Inconsistency of spacing above headings. An extra space above headings will 
set off new topics on the page; make the space above headings uniform from 
chapter to chapter. 

 Inconsistency of spacing above and below figures and tables. An extra space 
above and below a table or figure will set it off from paragraphs or other 
tables/figures on the same page; make the spacing around tables/figures uniform 
from chapter to chapter. 
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 Tables and figures in the margins. No text or graphics should appear in the 
margin areas of the page.  

Check also: 

 That the date on the title page reflects the month and year of final conference 
approval. 

 That there are no page numbers on the title page through the Abstract. 

 That Table of Contents entries match the corresponding chapter headings, and 
that page numbers are correct. 

 That every reference is cited in text and every text citation is correctly 
referenced. The reference list should not be a comprehensive bibliography; 
cross-check citations with references and vice versa. 

3. Following final conference approval, you will be sent a link to ProQuest/UMI, where 
you will be instructed to convert your document to PDF format (there is a link to the 
free use of PDF conversion software). Check the page breaks in the PDF file and 
correct any problems. 

4. The bound dissertations you order from ProQuest will be copied on two sides, and 
therefore the gutter margin (the margin closest to the binding) will be 1 in. on left-hand 
pages but 1.5 in. on the facing right-hand pages. If you want to adjust the page layout 
so that the gutter margin is always 1.5 in., the process is simple: 

 
Don’t do this until you are ready to convert to PDF:  In your Word document, click 
on File > Page Setup > Margins; under “Multiple pages,” click on “Mirror 
margins.”  Look over the manuscript and make sure that this change was made in 
every section and that top and bottom margins were not affected. 



 
 

 
 

© 2008 Capella University 14 

Dissertation Format Guidelines

 
 

 
MARGIN SPECIFICATIONS  

 
1 inch top margin 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.5 inch  
left margin 

 

 
 
 
 
 
 
 
 
 

. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Margins should be set at the settings indicated on this page. 
Writers are encouraged to use the Dissertation Template, 
which is already formatted with these margins.  
 
All text, figures, and tables must fit within the nonshaded 
area.  
 
The left margin ensures that there is a big enough gutter to 
accommodate the binding. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 inch 
right 
margin 

 

1.2 inch bottom margin 

1 inch footer margin (p. #) 

. 
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HEADING SAMPLE 

  
If you need one, two, or three levels of subheadings below the level 
5 chapter title, you would use APA heading levels 1, 3, and 4, as in 
this example: 

 

CHAPTER HEADING, APA LEVEL 5,  
CENTERED, ALL CAPS 

First Subheading, APA Level 1,  
Centered, Upper- and Lowercase 

Second Subheading, APA Level 3, Flush Left, Upper- and 
Lowercase 

Third subheading, APA level 4. The heading is indented 

and ends in a period, and the paragraph starts immediately on 

the same line. In a level 4 heading, only the first word and 

proper nouns are capitalized. 

 
Insert a level 2 heading, not shown above, only when a fourth 
subheading level is needed. Heading levels are described in APA 
3.31–3.32. 

Single-space headings (other than level 4) that extend beyond one 
line. 

Note that each subheading must have at least one counterpart at the 
same level under a particular heading.  
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LIST SAMPLE 

 
Creating a well-formatted list is as easy as 1, 2, 3. Here’s 

how: Ignore formatting and type the first entry (single-spaced) in 

your list, without a number. Next, 

1. Click on the numbering icon on the formatting toolbar. 
You now have your first number in the list, and it is 
indented from the left margin. 

2. Check the indent. If using the icon gives you only ¼ 
inch indent, make it ½ inch by either using the ruler 
(move the top marker to ½ inch), or changing the length 
of the indent in paragraph formatting: Click on Format 
> Paragraph and change the Left indentation to 0.5″. 

3. Click on Format, Paragraph, and change Spacing After 
to 12 pt. (which will double-space between numbers). 

When you hit Enter at the end of the first entry, your next entry 

will be correctly formatted. 

A numbered list is indented ½ inch from the left margin, with the second 
and subsequent lines further indented (hanging indent). Note that the 
numbers end in a period, not a parenthesis, and entries are single-
spaced, with a full space between each entry. 

Three approaches to effectively communicating in writing 

are (a) writing from an outline, (b) setting aside the first draft for 

a while, and (c) getting feedback. 

A list within a paragraph is initiated by a letter, not a number. Also note 
that in this example, a colon is not used before the list begins. (When 
do you use a colon? See APA 3.04.) 
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BLOCK QUOTATION SAMPLE 

  
Paragraphs are double-spaced throughout the manuscript. 

However, APA does allow for institutions to create their own 

style requirements for dissertations. 

Display a quotation of 40 or more words in a freestanding 
block of typewritten lines, and omit the quotation marks. 
Start such a block quotation on a new line, and indent the 
block about ½ inch from the left margin (in the same 
position as a new paragraph). . . . If there are additional 
paragraphs within the quotation, indent the first line of 
each an additional ½ in. . . . 
 When quoting, always provide the author, year, and 
specific page citation in the text, and include a complete 
reference in the reference list. . . . 
 If any incorrect spelling, punctuation, or grammar 
in the source might confuse readers, insert the word sic, 
italicized and bracketed, immediately after the error in the 
quotation. (APA Publication Manual, 2001, pp. 117-118) 
 
 

This block quotation is single-spaced and indented from the left margin; 
it is not right justified or indented from the right.  
 
Note that the end punctuation comes after the quotation, not after the 
citation. See APA 3.34–3.41. 
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REFERENCE LIST SAMPLE 

  
Bower, D. L. (1993). Employee assistant programs supervisory 

referrals: Characteristics of referring and nonreferring 
supervisors. Dissertation Abstracts International, 54(01), 
534B. (UMI No. 9314947) 

Bubenick, G. K. (2003). Improvement of key employee retention 
rates through attention to and nurturance of their 
neuropsychological preferences (Doctoral dissertation, 
Northcentral University). Retrieved June 22, 2005, from 
ProQuest Digital Dissertations database. (AAT 3117956) 

Church, B., Gaa, J., Nainar, S., & Shehata, M. (2005). Experimental 
evidence relating to the person-situation interactionist model 
of ethical decision making. Business Ethics Quarterly, 15, 3.  

Grinols, E. (1994). Microeconomics. Boston: Houghton Mifflin. 

Meloy, J. (2001). Writing the qualitative dissertation: 
Understanding by doing (2nd ed.). South Bend, IN: Erlbaum. 

Nestor, S. (2004). The impact of changing corporate governance 
norms on economic crime. Journal of Financial Crime, 
11(4), 347-352. Retrieved May 22, 2006, from EBSCO host 
database. 

Rudestam, K., & Newton, R. (2001). Surviving your dissertation: A 
comprehensive guide to content and process (2nd ed.). 
Thousand Oaks, CA: Sage. 

Rest, J., Narvaez, D., Thoma, S., & Bebeau, M. (1999, December 1). 
DIT2: Devising and testing a revised instrument of moral 
judgment. Journal of Educational Psychology, 91, 4. 

Create a hanging indent with paragraph formatting, not with line breaks or 
tabs at the beginning and end of every line. 
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Chapter 2. Creating Tables and Figures 
 
 
Whether to Include a Table or Figure 

Be judicious in using tables and figures in a dissertation. Easy-to-use software makes it 
tempting to include many tables and figures, but not all data need to be presented graphically.  

• Do not create a table or figure to present data or relationships that are limited or easy to 
describe. Unusually short and simple tables are more efficiently presented in text (see 
APA 3.54 and 3.62). 

• Tables are useful for the presentation of quantitative data. Figures typically require the 
reader to estimate values.  

• Do not include both a table and a figure that present the same data.  

Read APA 3.62–3.64 before deciding what data to include in tabular form, and read APA 
3.75–3.77 before deciding to use a figure. 
 
 
Formatting Tables and Figures 

• Tables are identified by rows and columns 

• Figures are charts, graphs, maps, diagrams, drawings, photographs 

Although APA’s discussion of tables and figures pertains mainly to articles submitted to 
journals, Capella dissertation style follows the APA recommendations with the exceptions 
explained below and shown in the samples at the end of this chapter.  
 

Numbering Tables and Figures 

1. In the chapters: Tables and figures are each numbered sequentially throughout the 
chapters; they do not contain the chapter number. See APA 3.65.  

2. In the appendixes: Tables and figures are numbered separately from those in the 
chapters. Refer to Appendix Tables and Figures in chapter 1 in these guidelines. 

3. In text, refer to tables/figures by number, not as “the table/figure above” or “below.” 
See APA 3.63. 

 

Table Titles  

1. Table titles go above the table, flush left, always in 12 points. Use initial caps for 
proper nouns and all words four letters and over. Read APA 3.66 for tips on writing 
table titles. 

2. Table titles that extend beyond one line should be single-spaced.  
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3. Table titles may be placed on the same line as the table number or on the line below, 
but be consistent.  

 

Text Within the Table 
1. See TABLE SAMPLES 1 through 3 in this chapter.  

2. Table text must be in the same font as the rest of the manuscript.  

3. In order to fit a long table on a single page, Capella allows 10- or 11-point type for the 
table text. For consistency, use the same size type in every table.  

4. Table headings and text may be single-spaced (double-spaced between rows).  

 

Rule Lines in a Table  
1. See TABLE SAMPLES 1 through 3 in this chapter.  

2. Insert a horizontal rule line between the title and the top row of the table. Insert another 
rule line below the last row of the table.  

3. Insert other horizontal lines only if they are necessary. 

4. Do not insert vertical or perimeter rule lines.  

5. Refer to the table examples in APA 3.62 and 3.69. 

 

Tables from Excel or SPSS  
Tables created in Excel, SPSS, or other software should be reformatted (correct font, size, 
rule lines) before they are imported into the dissertation. 

 

Notes to a Table 

1. See the discussion of types of notes in APA 3.70 and the notes in the table examples in 
APA 3.69.  

2. General notes to a table should follow the word Note, in italics, below the bottom rule 
of the table.  

3. For a table reprinted or adapted from another source, the note must contain the 
complete reference; see the discussion on Including Tables and Figures From Another 
Source, below. 

4. The table note should be 10 points, single-spaced; see TABLE SAMPLE 4 in this chapter.  
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Figure Captions 
1. See FIGURE SAMPLES 1 and 2 at the end of this chapter. 

2. Figure captions, always 12 points, go below the figure, flush left, or, if short, centered 
under the figure: be consistent.  

3. Use initial caps only for the first word and any proper noun.  

4. See APA 3.84 for tips on writing effective captions. 

5. Captions that extend beyond one line should be single-spaced.  

6. Any comments clarifying the figure and any source notes should be placed at the end of 
the caption, not below it.   

 

Color in a Figure 
Bound copies of the dissertation are not printed in color; therefore, the lines, bars, and legends 
in a graph with color must be distinguishable in black and white. If they are not, use shading, 
crosshatching, broken lines, or other monochromatic means to show the components of a 
graph. 

 

Placing the Table or Figure on the Page 

1. Insert a table or figure shortly after it is first discussed in the text. 

2. Tables should be aligned left; figures can be centered or aligned left. 

3. For a uniform look, use the same font size, spacing, and overall layout from table to 
table. As previously mentioned, tables from Excel or SPSS should be formatted 
correctly before they are imported into the document. 

4. Try to create tables that are not longer than a single page.  

5. Do not split a table between pages. To help fit tables on the page, Capella allows the 
following adaptations (for a uniform look, make these changes consistent from table to 
table): 

• Table text can be single-spaced (but spaced out between rows).  
• Table text can be reduced to 10- or 11-pt.  
• Table title can be placed on the same line as the table number.  

6. If a table is longer than a single page, repeat the number and title and add the word 
“continued” on the other page(s); also repeat column and row headers (see TABLE 
SAMPLE 2 in this chapter; see also Table Example 9 in APA 3.69). 

7. Separate a table or figure from paragraphs on the same page with an extra space above 
and below.  
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8. Avoid leaving a lot of white space on the page preceding a table or figure; move text 
forward. However, do not split a sentence to insert a table or figure; create two 
paragraphs out of one instead. 

 

Including Tables and Figures From Another Source 

Is it Necessary? 
Unless a table or figure reprinted or adapted from another source is critical to your discussion, 
you probably don’t need it. 
 

Fair Use 
“Fair use” in copyright law indicates that for an educational purpose (such as a dissertation), 
copyrighted material, if it is not a substantial amount, can be reproduced or adapted without the 
permission of the copyright holder. However, if the excerpt is substantial, the copyright 
owner’s permission must be sought. ProQuest indicates that fair use does not apply to a 
copyrighted graphic that constitutes an entire work; in such cases, you must obtain permission 
to reprint it. See chapter 5 in these guidelines. 

 

Citing Tables and Figures From Another Source 
The reference for a table or figure reprinted or adapted from another source is not the same as 
an in-text citation or reference list entry. The entire reference must include a page number as 
well as copyright and permission statements, if applicable. Refer to APA 3.73 and 3.84. 

• Table: See TABLE SAMPLE 4 in this chapter. The reference is placed in a note below the 
bottom table rule. Also refer to Table Examples 8 and 9 in APA 3.69. 

• Figure: See FIGURE SAMPLES 1 and 2 in this chapter. The reference is placed at the end 
of the caption.  
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Table and Figure Samples 

The table samples in this section differ from those recommended for APA journals in these 
ways: (a) The table number and title are on the same line and not italicized; (b) the table text is 
10 points, single-spaced; (c) the note is 10 points, single-spaced.  
 
 

 
TABLE SAMPLE 1 

 
Table 1. Alternative Hypothesis Results  

 
 N   t  P 
 

 
Supervision frequency  30 -2.50 0.02 
 
Employment 30 -1.99 0.06 
 
Education 23 1.39 0.18 
 
Substance abuse/use 26 0.00 1.00 
 
 
 
 
In this sample, decimal tabs were set so that the numbers would be 
aligned. Note that there is not a box around the table or border lines 
between the rows and columns. 
 
Tables created in Excel, SPSS, or other software should be reformatted 
(correct font, size, rule lines) before they are imported into the 
dissertation. 

 

 

 
 
 
 
 
 

 



 
 

 
 

© 2008 Capella University 24 

Dissertation Format Guidelines

 
 

TABLE SAMPLE 2 

 
Table 1. Alternative Hypothesis Results (continued)  

 
 N   t  P 
 

 
Supervision frequency  
 
Employment 
 
Education 
 
Substance abuse/use 
 
 

Note. N = number of subjects; t = t test statistical value; P = degree of 
significance.  
 
 
 
This sample shows how to continue a table on a second page. The table 
number and title are repeated, and the word “continued” added. Column 
and row headings are also repeated.  
 
If there are any notes, they are placed on the last page of the table. 
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TABLE SAMPLE 3 

 
Table 2. Descriptive Statistics for the Dependent Variables Across the 
Independent Variable 

 
 Style Mean SD N 

Ambig 1.00 
2.00 

Total 
 

12.26 
21.04 
14.25 

5.14 
9.67 
7.34 

41.00 
12.00 
53.00 

Stress 1.00 
2.00 

Total 
 

39.46 
58.85 
43.85 

14.51 
15.88 
16.81 

41.00 
12.00 
53.00 

Survey 1.00 
2.00 

Total 
 

64.78 
67.65 
65.43 

9.67 
8.39 
9.39 

41.00 
12.00 
12.00 

Conflict 1.00 
2.00 

Total 

27.20 
37.80 
29.60 

11.30 
9.92 

11.79 

41.00 
12.00 
53.00 

 
 
 

In this sample, table cells were used to create the rows and columns. The 
columns are right justified so that numbers are aligned by decimal. Table 
text is 10 points, single-spaced, with double-spacing between rows. 
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TABLE SAMPLE 4 

  
 

 

(bottom rule of table) 

Note. From “Title of Article,” by A. N. Author and C. O. Author, 
2005, Title of Journal, 50, p. 22. Copyright 2006 by the Name of 
Copyright Holder. Reprinted [or Adapted] with permission. 
 

 

(bottom rule of table) 

Note. From Title of Book (p. 103), by A. N. Author and C. O. 
Author, 2005, Place of Publication: Publisher. Copyright 2006 by 
Name of Copyright Holder. Reprinted [or Adapted] with 
permission. 
 
 
Tables reprinted or adapted from another source must show 
the entire reference, as well as copyright and permission 
statements, if applicable, in the note below the table. These 
examples are from APA 3.73. 
 
Note that reference list style is not used in source notes. 
 
If the work is not copyrighted, the copyright and permission 
statements would be excluded. 
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FIGURE SAMPLE 1 

 
Score Correlation 

 

 

 

 

 

 

 

 
 
 

Figure 1. Score correlation. Regression scatter graph shows perfect 
positive correlation between POR and LPI average scores. From 
Book Title (p. 103), by A. N. Author and C. O. Author, 2005, City, 
ST: Publisher Name. Copyright 2005 by Name of Copyright 
Holder. Adapted with permission. 
 
 
Note that figure captions are placed below the figure. Because of its 
length, this caption is aligned left rather than centered under the figure. 
 
Any clarifying comments and source notes follow the descriptive title. 
See APA 3.84. 

 

 

 
 
 
 
 

 
 

POR  
(Y-

LC  
 (X-

Units 1 
to 13 

Key: POR=Profitability on 
Rooms, LC=Leadership 



 
 

 
 

© 2008 Capella University 28 

Dissertation Format Guidelines

 
 

FIGURE SAMPLE 2 

 

Associate Degrees Conferred 
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Figure 2. Associate degrees conferred. From College Fact Sheet, 
2005. University Public Affairs. Ourstate College. Retrieved July 21, 
2006, from http://www.giveentire.URL.html 

 
 
Note that the legend and lines in the graph are distinguishable by the 
characteristics of the lines, not by color. Because bound copies of the 
dissertations are not printed in color, graphs and legends must be 
readable in black and white. 
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Chapter 3. Formatting Support 

APA-Capella “Discrepancies” 

Learners occasionally notice discrepancies between APA and Capella requirements, but these 
perceived conflicts in style are, in almost all cases, the distinctions between preparing a draft of 
an article and preparing a dissertation. The primary audience for the APA Publications Manual 
is researchers who are preparing draft manuscripts to submit to journals. Only chapter 6 of 
APA covers “materials other than journal articles.”  Capella’s Dissertation Format Guidelines 
incorporate the guidance in chapter 6. The most frequently mentioned discrepancies are 
discussed in Table 3. 

 
 
Table 3. APA-Capella “Discrepancies”  
 
Item APA Manual Capella dissertation style  

Abstract  APA 6.02 states that “Many 
institutions require that abstracts 
be prepared according to the 
requirements of Dissertation 
Abstracts International. The 
maximum length for a 
dissertation abstract submitted to 
[DAI] is 350, far longer than the 
maximum of 120 for most 
abstracts in APA journals.”  

 

The Abstract should be no longer than 
350 words.  

It is not necessary to fully justify the 
paragraph formatting of the Abstract. 

See chapter 1 of these guidelines. 

Single-spacing APA 6.03 indicates that double-
spacing is required throughout 
most of the manuscript but that 
single-spacing can be used to 
improve readability.  

Single-space headings; table titles, 
column headings, table text, and 
notes; figure captions; numbered lists; 
table of contents entries that run 
longer than one line; reference list.  

Single-space long table entries, and 
separate the rows with an extra space. 

Single- or double-space block 
quotations, but be consistent 
throughout the manuscript.  

See chapter 1 of these guidelines. 
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Table 3. APA-Capella “Discrepancies” (continued) 
 
Item APA Manual Capella dissertation style  

Single-spacing the 
references 

APA explains on p. 239, “In a 
manuscript submitted for 
publication, all references are to 
be double-spaced; when typeset, 
they will be converted to a single-
spaced page,” but section 6.03 
indicates that single-spacing can 
be used to improve readability. 

 

The dissertation will be published as 
is; it will not be typeset. Single-
space the references, double-spacing 
between each entry. 

See the REFERENCE LIST SAMPLE in 
chapter 1 of these guidelines. 

Formatting block 
quotations 

The block quotation example in 
APA 3.34 is fully justified only 
because all of the text in the APA 
Manual is fully justified, not 
because it is an APA requirement. 

 

Do not fully justify the formatting of 
a block quotation. See the BLOCK 
QUOTATION SAMPLE in chapter 1 in 
these guidelines. 

Placement of 
tables and figures 

APA 6.03 specifies that tables be 
neatly integrated into the text. 
APA 5.21 discusses beginning 
tables on separate pages, but that 
discussion has to do with 
submitting an article to a journal. 
As the beginning of chapter 5 
states, “If you are preparing a 
thesis or dissertation, some of 
these instructions may not apply; 
see chapter 6, and consult with 
your advisor.”  

 

Insert a table or figure shortly after 
it is discussed in the text.  

See chapter 2 of these guidelines.  

Font size in tables APA 3.72 indicates that table text 
should not be reduced (however, 
APA’s own notes in its table 
samples are smaller than its table 
text). 

 

Set all tables in the same size font. 
Table text can be as small as 10 pt. 
Notes to tables should be 10 pt.  

See the TABLE SAMPLES in chapter 
2 of these guidelines. 
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Table 3. APA-Capella “Discrepancies” (continued) 
 

Item APA Manual Capella dissertation style  

Notes to tables and 
figures 

APA places notes to tables below 
the table content. APA includes 
copyright information for figures 
as part of the caption. 

Place notes for tables directly below 
the bottom rule of the table. Place 
notes for figures at the end of the 
caption.  

See the TABLE SAMPLE 4 and 
FIGURE SAMPLES 1 and 2 in chapter 
2 of these guidelines. 

 

Heading levels 

 

Many of APA’s samples are 
drafts of articles for submission to 
journals. They are not dissertation 
manuscripts. 

 

Capella uses the level 5 heading for 
chapter titles, typically followed by 
levels 1, 3, and 4. See chapter 1 of 
these guidelines. 

Spacing above 
headings 

“Judicious triple- or quadruple 
spacing can improve appearance 
and readability. Such spacing is 
appropriate after chapter titles, 
before major subheading . . . and 
before and after tables in the text” 
(APA 6.03). 

Enter an extra space (return) above 
level 1 headings to set off new 
topics from the paragraph above. (It 
may also improve readability in a 
long document to enter an extra 
space above level 2 and level 3 
headings.) 

See chapter 1 of these guidelines. 
 

 
 
 

Working in Microsoft Word 
A caveat: These guidelines do not address the new features of Word 2007. 

This is not a section on how to use Word, but rather a section on how to format a Capella 
dissertation using a template from a common word processing software. Word’s default 
formats cause confusion and frustration for some writers. While writers do not need to be 
expert word processors, they will find the manuscript preparation process much more 
rewarding if they familiarize themselves with the basic functions of the Word program. Being 
aware of features such as defaults, table formatting, document rulers, and so forth will ease 
writer frustration. 
 
For best success, Capella writers should use their school’s standard Dissertation Template. The 
template has been designed to ensure that the margins, headers and footers, section breaks, 
font, and spacing are correct. Again, be wary of using dissertation samples or of cutting and 
pasting over an old document. Rather, use a new standard template from your School. Writers 
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who choose not to use the template may end up spending unnecessary hours addressing some 
basic word processing functions. 
 
 
Frequent Sources of Frustration 
Aligning page numbers in the Table of Contents. All page numbers on the Table of Contents 
should be aligned. Options for doing this include setting a right tab, setting a number tab, or 
setting the Table of Contents as a two-column table with the page numbers in a column set 
right justified.   
 
Curly quotation marks. Pasting text from document to document often changes “curly” 
quotation marks (which match the style of serif fonts such as Times New Roman) to “straight” 
ones. If this bothers you and you want to make them consistent, click on Edit, Replace. After 
“Find what” enter a quotation mark; do the same after “Replace with”; then click on Replace 
All. That will fix all of the double quotation marks. Do the same with single quotation marks. 
 
Ellipses. Ellipses are rarely needed at the beginning or end of a direct quotation, including a 
block quotation. See APA 3.38. But when they are used, the ellipsis points should be spaced 
out (as in . . . ).  Note that your word processing program might automatically remove the 
spaces as you type; you can change that in Tools > Auto Correct Options. 
 
Hanging indent. Create a hanging indent for the reference list on one of two ways. Either  
(a) use the Ruler and move the bottom marker to one-half inch, or (b) click on Format > 
Paragraph > Indents and Spacing > Indentation > Special: Hanging.   
 
Headings. If the paragraph format includes an indented first line, then your headings likely 
will have an indent until you remove it. If some centered headings look a bit off-center, remove 
the indent with the Ruler or click on Format > Paragraph > Indentation. 
 
Hyperlinks. Microsoft Word defaults to live hyperlinks. However, there are two reasons not to 
use hyperlinks. 

• From a content longevity standpoint, hyperlinks to external documents are unreliable 
because Web sites and pages frequently go offline or are revamped, making the 
hyperlink useless. 

• From a typographical standpoint, APA and Capella do not allow color font or 
underlined text, yet hyperlinks are preset to appear in blue, underlined text. When 
printed in one color, the blue will appear as a washed-out grey, and the underlining will 
call attention to itself. (NOTE: this does not include a hyperlinked Table of Contents.) 

In the reference list, allow URLs to wrap from one line to the next by adding a 
space after a slash or before a period (see APA 4.16 example 74, last bullet); right click 
to remove the hyperlink. 

 
Numbered lists.  Use the Numbering icon to easily format your lists with a hanging indent, 
with the second and subsequent lines aligned under the text in the first line. However, you 
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should adjust the indent to one-half inch because Word’s default indent for numbered lists is 
only one-quarter inch.  
 
Placement of page numbers. Use the footer option (Insert > Page Numbers > Position) to set 
the lowercase roman numeral page numbers for the preliminary material (see Table 2 of this 
chapter) and the arabic page numbers for the body of the manuscript. Never type the page 
numbers at the bottom of the “screen page,” as this causes enormous issues during the revision 
process.  
 
Section breaks. Working with sections breaks is by far the most frustrating aspect of working 
on a large document, such as a dissertation. Writers using the Capella dissertation templates 
should take care not to accidentally delete section breaks. These section breaks have been set  
to ensure that the formatting of each section is correct.  
 
Spacing between sentences. APA recommends that you use one space between sentences, 
although it does not require you to do so. Similarly, Capella recommends using only one space 
between sentences. Indeed, it is standard typographic practice to use one space between 
sentences. APA’s Web site describes the rationale for one space between sentences: “Unlike 
manual typewriters, word-processing software uses fonts that result in proportional spacing, so 
additional spacing around periods is no longer necessary.” 
 
Spacing with dashes. Writers should not use spaces on either side of an em—or long—dash. 
This extra white space is a distraction, and it also causes the automatic em dash to default to 
two hyphens. 
 
Spelling. Capella’s standard dictionary is the Merriam-Webster’s Collegiate Dictionary (11th 
ed.), APA’s preferred dictionary. Writers are reminded not to trust their word processing 
program’s built-in dictionary, particularly for words with prefixes. APA 3.11 discusses 
hyphenation; Tables 3.1 and 3.2 cover basic hyphenation rules. If you are in doubt, do not trust 
your word processor—look up the word in Webster’s.  
 
Tab key versus the space bar. The standard default indentation for new paragraphs (including 
numbered lists) is one-half inch. All word processing programs have a one-half inch default 
tab. Writers should never use the space bar to indent new paragraphs. Not only is the eye less 
accurate than the ruler, but the individual width of typeset letters will affect the spacing so that 
indentations of new paragraphs become imprecisely aligned.  
 
Table borders. When creating tables, the Word program automatically defaults to border lines 
around the cells in the table, as does SPSS and other statistical software. As discussed in 
chapter 2 of these guidelines, writers should remove the border lines from the table perimeter, 
all of the vertical border lines, and most of the horizontal border lines. See the TABLE SAMPLES 
in chapter 2. Use the table formatting function of the word processing program; consult your 
Help menu if you are unsure. 
 
Text wrap. The text wrap function automatically brings the line of text from the right margin to 
the left margin of the next line. Word processing novices should take special care to use the 
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automatic text wrap function rather than adding a line break or a hard return. This principle 
also holds for block quotations, which should be allowed to wrap from the end of a line to the 
one-half inch left indent on the next line. 
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Chapter 4. Common Errors Flagged by Capella Editors 
 
Confidentiality Issues 
 
Capella, its IRB, ProQuest, and APA all take the protection of human participants very 
seriously.  
 

1. Writers must have the appropriate written approval before conducting their research.  
 

2. Writers should make participants aware that the dissertation is published on the 
Internet. 

• The typical assumption is that the printed and bound dissertation will be shelved in 
the stacks of a library, because historically this has been true. Many brick-and-
mortar institutions still do this.  

• Research participants and institutions should be told in writing that the entire 
dissertation will be published on the Internet. Previously, the abstract had been 
published online, but now the entire dissertation is available for download to 
interested readers. 

• Writers should be mindful of this issue, even if sensitive data are not disclosed and 
the results do not adversely reflect on participants or the research site. 

 
3. If human contact or involvement constitutes part of the research activity, writers should 

discuss critical respondent issues in the methods chapter of the dissertation, along with 
matters of security and handling of data, informed consent, and maintaining respondent 
confidentiality.  

 
4. Confidentiality protections extend from the recruitment activities to the dissertation’s 

publication. Therefore, writers should carefully “deidentify” the text to the fullest 
degree possible.  

• The final manuscript should not include any actual names of participants or other 
personal information such as addresses, e-mail addresses, or telephone numbers.  

• Even identifiable pseudonyms (such as those used on the Internet) should be 
changed to protect the confidentiality of participants. 

• Institutional names and their locations also need to be sufficiently generalized to 
avoid breaches of confidentiality. 

 
Refer also to chapters 6 and 8 of the Dissertation Manual; also see the discussion of case 
studies in APA 1.04 and of confidentiality in APA Appendix C §5.02 and §5.08. 
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Format and Style Issues  
 
The following issues from both APA and Capella styles are frequently noted by editors in their 
dissertation reviews. The issues are listed alphabetically. 
 
“And” versus the ampersand. See APA 3.95 on the use of the word “and” and the use of the 
ampersand (&). Join the names in a multiple-author citation in manuscript text with the word 
“and.” Join the names with an ampersand in parenthetical material, in tables and captions, and 
in the reference list. Doing a search (Edit > Find) can help you quickly find incorrect uses of 
the ampersand. 
 
Anchors of scales. Anchors of scales take italics. Do not use underlining or quotation marks. 
See the example in APA 3.19. 
 
Block quotations. Format all quotations of longer than 40 words as block quotations. See 
chapter 1 of these guidelines and APA 3.34, noting that block quotations are indented one-half 
inch from the left—the length of a standard paragraph indent—and run to the right margin 
before wrapping back to the one-half inch indented left margin. The terminal punctuation for 
block quotations should be placed at the end of the quotation itself, not after the parenthetical 
reference information. You may either single-space or double-space block quotations, but be 
consistent throughout your manuscript. You will find the Word Count feature under the Tools 
menu of your word processing program quite helpful for checking this item. 
 
Bold and underlining. APA does not allow the use of bolded or underlined text. If the original 
source material for a direct quotation used bold or underlining, remove it and indicate your 
change in brackets, like so [bolded in original] or [underlined in original]. 
 
Bullets. Do not use bullets in Capella dissertations. Use numbers instead. If an original source 
uses bullets, change the bullets to bracketed numbers, as in [1], [2], [3], and so on. 
 
Citation of sources. Writers must correctly cite all direct quotations and include a page 
reference (a page reference for a paraphrase or summary is optional). APA 3.39 discusses 
citing sources and offers useful guidance on locator information for electronic sources. 
 
Color. It is best to set the manuscript in black. Color fonts will appear washed out when the 
dissertation is printed in one color, as the final bound copy will be. If you must use color (as 
for a figure from an outside source or a graphic element in an appendix item), be sure that the 
image is dark enough to be readable. See the discussion of color in a figure in chapter 2 of 
these guidelines. 
 
Commas in a series. Use a comma to separate three or more words or phrases (without internal 
punctuation) in a series. Place the comma before the conjunction that joins the last item to the 
others (e.g., bachelor’s, master’s, and certificate learners). 
 
Definitions. According to the Dissertation Manual, definitions should be drawn from research 
from within the field. Generic encyclopedias and dictionaries are not considered scholarly 
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sources; the online encyclopedia Wikipedia should be avoided since the material is subject to 
text changes and might not have the consensus of experts in a particular field. 
 
Heading hierarchy. Refer to the HEADING SAMPLE in chapter 1 of these guidelines for 
Capella’s heading formats. The best way to check for proper heading levels is to go through the 
hard copy of the manuscript with a highlighter, creating a comprehensive outline on another 
sheet of paper as you go. This will help you establish your heading hierarchy and point out any 
heading levels are not correct. 
 
Hyphens. APA 3.11 discusses hyphenation; in that section, Tables 3.1 and 3.2 cover basic 
hyphenation rules. Note that most self- words take hyphens. Most prefixes such as multi, non, 
and pre typically do not require hyphens. Most compound adjectives take hyphens when they 
precede the word they modify. The Merriam-Webster’s Collegiate Dictionary (11th ed.) is 
APA’s preferred dictionary, and it is an excellent resource for determining questionable 
hyphenations. 
 
Multiple works in a citation. For all in-text citations, “List two or more works by different 
authors who are cited within the same parentheses in alphabetical order by the first author’s 
surname” (APA 3.99).  
 
Paragraph spacing. The standard paragraph spacing for all dissertation text is double-spacing, 
with 0 points before and after. When the point spacing is off, it creates more space between 
paragraphs than is standard or necessary, which detracts from readability. Use the formatting 
features of your word processing program to check the paragraph spacing (Format > Paragraph 
> Alignment or Spacing).  
 
Placement of the page number, chapter heading, and first line of text.  

1. The page number should be set 1 inch from the bottom of the page and centered in 
the footer.  

2. The APA level 5 chapter heading on the first page of each chapter should be set at 2 
inches from the top of the page. 

3. The first line of text on the second and subsequent pages of each chapter should 
begin 1 inch from the top of the page. 

 
Placement of punctuation with quotation marks. Be aware of the rules governing placement 
of punctuation with closing quotation marks. See APA 3.36: “Place periods and commas 
within closing single or double quotation marks. Place other punctuation marks inside 
quotation marks only when they are part of the quoted material.” 
 
Quotation marks, single versus double. Single quotation marks are used only to replace any 
double quotation marks that might have been used in the original quotation of an in-paragraph 
direct quotation. In all other cases, use either double quotation marks or italics (see APA 3.06 
and 3.19 for a discussion of both). 
 



 
 

 
 

© 2008 Capella University 38 

Dissertation Format Guidelines

Reference list. The format editor will scrutinize the reference list against APA style. Here are 
some common errors for which explanations and remedies may be hard to find. 

1. The reference list is not a comprehensive bibliography. Therefore, every reference 
should be cited in text, and every text citation should be correctly referenced (see 
the Dissertation Manual). 

2. If an author is not given, do not use “Anonymous” unless the work is signed as such 
(see APA 4.04, bottom of page 221). Follow APA 4.16 examples 8, 26, and 77 for 
formatting works with no author. 

3. Alphabetize article or book titles when no author is given by the first significant 
word, not “A,” “An,” or “The” (see APA 4.04 and 4.16 example 8). 

4. Do not add the URL when a search database is used (see APA 4.16 examples 88 
and 90). 

 
Statistical symbols and mathematical copy. 

1. Many statistical symbols, including n, N, t test, and SD, take italics. Please see APA 
3.58.  Table 3.9, in particular, is quite helpful on which statistical symbols need 
italics.  

2. APA 3.59 discusses the spacing requirements for mathematical copy.  
 
 
Useful Resources 

The Dissertation Format Guidelines 
Writers are urged to carefully read the Dissertation Format Guidelines. These guidelines have 
been created specifically to assist writers in preparing their manuscripts.  
 
The Publication Manual of the American Psychological Association (5th ed.) 
Many faculty members suggest that writers “use APA” or “look in APA” for formatting. For 
this reason, Capella’s dissertation formatting requirements adhere closely to APA. (See APA-
Capella “Discrepancies,” above, for specific distinctions). Thus, if writers have not already 
done so, they should purchase a hard copy of the APA Manual. 
 
The APA Web site 
Visit http://www.apastyle.org for further formatting guidance. The site also contains an 
erratum document for the fifth edition, which lists typographical and editing errors. 
 
Capella’s Standard Dictionary 
The Merriam-Webster’s Collegiate Dictionary (11th ed.) is the standard dictionary for both 
Capella and APA. As mentioned above, Microsoft Word’s default dictionary frequently flags 
correctly spelled words as errors. When in doubt, writers should consult Webster’s.  
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The Chicago Manual of Style. 
Writers who have specific formatting or style issues not covered by these guidelines or the 
APA Manual should consult Chicago Manual of Style, which APA itself used as a reference in 
preparing its style. Chicago will provide the answers on formatting epigraphs, on why the 
preliminary material takes roman numerals, on capitalization of job titles and educational 
degrees, and on other highly specific topics. Finally, it has an excellent discussion on forming 
possessives. 
 
A Grammar and Mechanics Reference That Works for You 
The APA Manual provides only skeletal information of grammar and mechanics, so writers 
may find it helpful to use a supplemental reference. There is no “right” text or reference 
source: it is a matter of personal preference. At a minimum, writers can consult the “Handbook 
of Style” at the end of the Webster’s. 
 
Show Me the Numbers: Designing Tables and Graphs to Enlighten 
This book by Stephen Few is both an overview of table and figure design and a handbook on 
designing your own tables and figures. In addition to discussion of what makes a good table or 
figure, Few also provides many examples of what makes a poorly designed table or figure. Few 
writes in an informative yet accessible tone. The book also contains a number of exercises to 
help writers discover the best way to present their data in table or figure format. 
 
Thinking With Type 
This site is a companion to Ellen Lupton's book of the same name. Writers who struggle with 
paragraph spacing, page layout, or incorporating tables and figures neatly in the manuscript can 
gain some graphic design hints. This accessible site provides a gentle overview of typography 
and page design. http://www.papress.com/thinkingwithtype/index.htm 
 
Edward Tufte  
Tufte is the world's premier advocate for improving the visual display of quantitative 
information. Writers seeking guidance on creating aesthetically appealing, highly readable 
tables and figures will find much to ponder in Tufte's work. Use this site for inspiration rather 
than "how-to" instruction. http://www.edwardtufte.com/tufte/ 
 
Outside Editors, Proofreaders, Writing Facilitators, and Word Processing Specialists 
Things to keep in mind. Writers may choose to hire someone to assist them in the dissertation 
process. If you do choose to hire someone, note the following suggestions: 

1. Clarify expectations. What do you expect from the person you hire in terms of fee, 
turnaround time, delivery method, and so on? 

2. Clarify how you want to receive your feedback.  

3. Make certain that the individual is well-versed in APA formatting.  

4. Provide the individual with a copy of the template and the Dissertation Format 
Guidelines. 



 
 

 
 

© 2008 Capella University 40 

Dissertation Format Guidelines

 
What type of help do you need? 

Editors. Content editors focus on the entire manuscript. You can expect a content editor to 
comment on the manuscript’s overall organization and development as well as grammatical 
and mechanical issues.  
 
Proofreaders. A proofreader will read the manuscript differently than an editor will. 
Proofreaders and copy editors comment less on the actual content and more on the prose 
itself: you can expect specific line item corrections such as spelling, misplaced modifiers, 
missing references, and so on. 
 
Word processing specialist. A word processing specialist will focus on the actual hands-on 
production of the document. This service can range from table and figure formatting to 
pagination to proper presentation of the references. 
 
Writing facilitator. A writing facilitator or writing coach will work one-on-one with a 
writer to address whatever needs the writer may have. For example, a writing facilitator can 
work with you on grammatical issues, overall content organization, or on reference and fact 
checking.  
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Chapter 5.  Crediting the Work of Others 
 
What is Copyright Compliance? 

For this discussion, copyright compliance means that you, the writer of the dissertation, 
ensured that you have properly credited someone else’s work. Unlike the standard author-date-
page number citation of sources, copyright compliance can involve seeking permission to use 
the work in question.  
 
Copyright law can be complex. Further, protection of intellectual property is a subject of much 
focus and rapid change. At the same time, there are some basic processes to assess whether you 
are in compliance and some basic presentation for formatting your compliance information. 
 
 
Is Your Proposed Use “Fair Use”? 
ProQuest has an extremely helpful discussion on copyright. Excerpted below are highlights 
from “New Media, New Rights, and Your New Dissertation,” by Kenneth D. Crews, Copyright 
Law and Graduate Research. Copyright 2000, ProQuest Information and Learning. The book 
is discussed in the ProQuest publishing agreement, which is linked at this Web site: 
http://dissertations.umi.com/capella/  
 

Fair use law favors educational uses over commercial uses. Your dissertation is 
fundamentally “educational,” but once you make it available for sale through ProQuest 
or most other publishers, it takes on some characteristics of a commercial product. . . . 
Be critical of simplistic answers about fair use; study instead the substantiality of your 
quotations or other uses of copyrighted works. Evaluate their proportion of the whole 
from which they come. Evaluate whether you are using the central “essence” of the 
original work. Evaluate whether the amount that you are using is necessary for serving 
your research purpose. . . . 

Long quotations. ProQuest raises questions about quotations from pre-existing 
materials that extend for more than one and one half single-spaced pages. . . . 

Reproduced publications. Avoid reproducing significant amounts of textual 
material in the format or page layout in which it was originally published elsewhere. 
Examples include copies of standard survey instruments or questionnaires and journal 
articles. . . . 

Graphic or pictorial works. Reproducing a picture, chart, graph, drawing, or 
cartoon often constitutes copying the owner’s entire work; thus, the “amount” factor 
under fair use may weigh against fair use. . . . 

Sources located on the Internet. The Internet is a rich trove of text, graphics, 
and other resources, but easy availability does not change the copyright status. 
Materials on the Web are protected by copyright just as if they appeared in a book or on 
tape.  
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How Do You Protect Yourself? 

The issue of copyright compliance in dissertations comes up most frequently when tables or 
figures from another source or reprinted documents are used. Even though the work will be 
referenced in your text, you may need to obtain permission to duplicate or adapt it.  
 
Permission not Needed 

• If your use of a copyrighted work falls under fair use, you do not need permission to 
use the work, but you must still reference it (see Source Reference, below).  

• Works considered in the “public domain,” that is, never copyrighted or no longer 
copyrighted, may be used without requesting permission but must be completely 
referenced. 

 
Permission Needed 

• If your use might not be considered fair use, you should request permission to use the 
material. See APA 7.01. A sample permission letter is included in the ProQuest 
publishing agreement, which you can link from http://dissertations.umi.com/capella/ 

• You must have written permission to reprint both unmodified and modified survey 
instruments. Read the discussion on What to Include in an Appendix, in chapter 1 of 
these guidelines. 

• You should begin the permissions process as soon as you know you will be using 
material that may not fall under fair use, since the process may take several weeks. 
ProQuest warns that publications may be delayed for copyright compliance issues. 

• Permission letters you receive to reprint copyrighted material should be forwarded to 
ProQuest/UMI when you publish (see their publishing agreement). These letters should 
not be included in an appendix. 

 
Source Reference  
The reference for a work that has been reprinted or adapted from another source must be 
complete and placed below the table/figure or reprinted document.  

Note: This reference is not in the abbreviated form of an in-text citation, and it contains more 
information than a reference list entry. It includes, in this order: title, author, date, publisher or 
retrieval information, copyright date and owner, and permission statement. 

• Tables and figures: In chapter 2 of these guidelines, read the discussion on Including 
Tables and Figures From Another Source and see TABLE SAMPLE 4 and FIGURE 
SAMPLES 1 and 2.  APA 3.73 should be your guide for placing and formatting reference 
notes for tables and figures.  

• Scanned or reprinted documents: The reference must contain the same information as 
that in a table note—title, author, date, publisher or retrieval information, copyright 
date and owner, and permission statement. It should be placed at the end of the scanned 
or reprinted material. 
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Chapter 6. School-Specific Information 

Each school has its own template for learners to use when preparing their dissertations. Careful 
observance of the template’s formatting will save you a great deal of time and frustration. If 
you have questions regarding specific aspects of the template, you should discuss them with 
your mentor. 
 
The templates are available by accessing the links below or following this path on Learner 
iGuide: Advising & Resources > Learner Resources > Dissertation > [either] Psychology [or] 
Other Schools. (The templates appear under the heading “Form and Style Resources.”) 
 
School of Business Technology Template 

School of Education Template 

School of Human Services Template 

School of Psychology Template 

 


